
Начало работы с портативными 
системами согласования сигналов 
SCC 
В данном руководстве описывается установка и настройка SCC модулей компании National 
Instruments. При этом предполагается, что ваша система уже содержит настроенное 
многофункциональное устройство сбора данных (DAQ устройство), которое будет 
присоединяться к шасси SC-2345/2350. Если этого ещё не сделано, следуйте инструкциям, 
приведенным в документе Начало работы с системами сбора данных из комплекта 
поставки вашего DAQ устройства. 
Примечание. В данном документе описывается настройка SCC модулей с помощью 
программного интерфейса NI-DAQmx. 
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Условные обозначения 
Следующие условные обозначения будут использоваться на страницах данного 
руководства: 



» 

Символ » обозначает последовательность вызова пунктов 
вложенных меню и разделов диалоговых окон для выполнения 
какого-либо действия. Например, последовательность File»Page 
Setup»Options обозначает, что сначала необходимо выбрать меню 
File, затем пункт Page Setup и, наконец, раздел Options в 
диалоговом окне. 

♦ Этот символ означает, что следующий за ним текст относится к 
определенному устройству, операционной системе или версии 
программного обеспечения. 

 Эта иконка обозначает примечание, содержащее важную 
информацию. 

 

Эта иконка обозначает предупреждение, советующее обратить 
особое внимание на действие, которое может вызвать повреждение 
устройства, потерю данных или сбой операционной системы. Если 
таким символом отмечено оборудование, обратитесь к 
поставляемому вместе с ним документу Read Me First: Safety and 
Radio-Frequency Interference для обеспечения необходимых мер 
предосторожности. 

 
Этим символом отмечено оборудование, при работе с которым 
следует принять меры предосторожности во избежание удара 
электрическим током. 

 
Этим символом отмечено оборудование, один из элементов 
которого может быть сильно нагрет. Прикосновение к нему может 
вызвать ожог. 

bold 
Жирным шрифтом выделены пункты меню и опции диалоговых 
окон, которые необходимо выбирать при работе с программным 
обеспечением. Жирный текст обозначает также названия 
параметров и элементов оборудования. 

italic Курсивом обозначены переменные, фразы с особым значением, 
перекрестные ссылки и ключевые термины. 

monospace Этот шрифт используется для имен разделов жестких дисков, 
путей и папок. 

monospace 
italic Данным шрифтом обозначено место ввода текста или значения. 

SCC-AIXX Обозначает модули SCC-AI01, SCC-AI02, SCC-AI03, SCC-AI04, 
SCC-AI05, SCC-AI06, SCC-AI07, SCC-AI13 и SCC-AI14. 

SCC-LPXX Обозначает модули SCC-LP01, SCC-LP02, SCC-LP03 и SCC-LP04. 



SCC-TC0X Обозначает модули SCC-TC01 и SCC-TC02. 

SCC-XX Обозначает любой из SCC модулей. 

SCC-SGXX Обозначает модули SCC-SG01, SCC-SG02, SCC-SG03, SCC-SG04 и 
SCC-SG24. 

 
Обзор измерительной системы 
На рисунке 1 изображены составные части измерительной системы, расположенные в 
порядке обработки реального физического сигнала. 

Измерительное приложение 

Среда разработки приложений 
LabVIEW, LabWindows/CVI, Measurement Studio или др. 

Настройка 
Measurement & Automation Explorer 

(MAX) 

Интерфейс прикладного программирования (API) 
NI-DAQmx, Traditional NI-DAQ, NI-SWITCH или др. 

Драйвер 
NI-DAQmx, Traditional NI-DAQ, NI-VISA 

Сбор данных с помощью DAQ плат и модульных приборов 

 
Согласование сигналов 

 
Датчики и измерительные преобразователи 

 
Сигналы и физические явления 

 
Рисунок 1. Схема измерительной системы 
Датчики и измерительные преобразователи служат для детектирования физического 
явления. Полученный сигнал преобразуется системой согласования к форме, подходящей 
для ввода в измерительное устройство, которое передает данные в компьютер. 
Программное обеспечение, установленное на компьютере, управляет измерительной 
системой, сообщая, когда и из какого канала получать либо генерировать данные. Кроме 



этого, ПО принимает необработанные данные, анализирует их и представляет в форме, 
удобной для восприятия, такой как график, диаграмма, или позволяет сохранить их в файл. 
Измерительные устройства и среды разработки приложений, созданные компанией NI, 
поставляются вместе с инструментальным драйвером NI-DAQ, позволяющим использовать 
все возможности устройства в настройке и получении/генерации данных. Таким образом, 
NI-DAQ избавляет от необходимости вручную программировать эти функции. 
Программные среды разработки приложений, такие как LabVIEW, LabWindows™/CVI™ и 
Measurement Studio, посылают команды драйверу на сбор и возвращение считанных 
данных, а затем отображают и анализируют полученные результаты. 
Драйвер NI-DAQ может использоваться в любой из сред программирования компании NI, а 
также в средах, поддерживающих вызов динамически подключаемых библиотек (DLLs) с 
помощью интерфейсов ANSI C. Вне зависимости от выбранной среды программирования 
ваше приложение по сбору данных будет всегда использовать NI-DAQ, как показано на 
Рисунке 1. 
Если устройство сбора данных и соответствующее ПО NI-DAQ до сих пор ещё не 
установлено, это необходимо сделать в соответствии с документом Начало работы с 
системами сбора данных. 
Шаг 1. Распаковка шасси и модулей 
SCC модули поставляются в антистатической упаковке, чтобы предотвратить их 
повреждение статическим электричеством. 
Внимание. Ни в коем случае не дотрагивайтесь до открытых контактов устройства. 
Во избежание повреждения, примите следующие меры предосторожности: 
•наденьте антистатический браслет или возьмитесь за заземленный объект 
• перед тем, как извлечь модуль из упаковки прикоснитесь антистатической упаковкой к 
металлической части заземленного корпуса компьютера. 
Извлеките модули из упаковки и осмотрите их на предмет отсутствия необходимых 
элементов и механических повреждений. Если модули окажутся поврежденными, 
обратитесь в представительство NI. Не устанавливайте поврежденные модули в шасси. 
Если модули не используются, храните их в антистатической упаковке. 
Информацию о безопасном применении устройства и его соответствии техническим 
требованиям можно найти в поставляемой вместе с ним документации, а также на CD 
диске NI-DAQ 7.x Device Documentation из набора NI-DAQ или на сайте ni.com/support. 
После установки обозревателя документации Device Document Browser соответствующий 
документ можно будет найти в меню Start»Programs»National Instruments»NI-
DAQ»Browse Device Documentation. 
Шаг 2. Проверка комплектации 
Убедитесь, что у вас есть следующие компоненты системы SCC. 



1 SCC Модуль 
2 Модуль питания 

4 Экранированный кабель 
3 Шасси SCC 

5 Устройство сбора данных  
6 Персональный компьютер 

Для создания полной системы сбора данных вам потребуется следующее: 
� Оборудование и документация 
– 68-контактное DAQ устройство М серии и документация к нему 
– 68-контактный кабель 
– Шасси SC-2345/2350 и руководство SC-2345/2350 User Manual 
– Один или несколько SCC модулей и руководство пользователя 
� ПО и документация 
– Драйвер NI-DAQ 7.2 либо его более поздняя версия и документация к нему 
– Одна из следующих сред разработки: 
• LabVIEW 
• LabWindows/CVI 
• Visual C++ 
• Visual Basic 
� Другие принадлежности 
– Плоская отвертка с шириной жала 1/8” 
– Крестовые отвертки 1 и 2 
– Устройство для снятия изоляции с проводов 
Для правильной установки драйвера NI-DAQmx обратитесь к документу DAQ Quick Start 
Guide, который можно найти на странице ni.com/manuals. Перед установкой шасси SC-
2345/2350 причитайте руководство пользователя SC-2345/2350 User Manual. 
Шаг 3. Присоединение шасси SC-2345/2350 к DAQ 
устройству М серии 
Внимание. Перед снятием крышек с устройств или присоединением/отсоединением 
любых сигнальных проводов сначала ознакомьтесь с документом Read Me First: Safety and 
Radio-Frequency Interference. 
Прежде всего, DAQ устройство М серии должно быть уже установлено в компьютере. 
Инструкции по установке содержатся в руководстве пользователя, прилагаемого к 
устройству. 
Присоедините шасси SC-2345/2350 к устройству М серии с помощью 68-контактного 
экранированного кабеля. Для этой цели служит разъем J24 на шасси SC-2345/2350. 
Расположение разъема показано на рисунке 2. 



1 Разъем J24 2 Индикаторы питания 3 Шасси SC-2345 
 
Рисунок 2. Расположение разъема J24 
Клемма заземления шасси SC-2345/2350 и металлическая накладка, фиксирующая 
сигнальные провода и защищающая от электромагнитных помех, предназначены для 
зануления «плавающих» источников сигнала (максимальный ток 1 мА). Не используйте эти 
клеммы для заземления шасси с целью обеспечения электрической безопасности. 
Дополнительная информация по этому вопросу содержится в руководстве пользователя 
SC-2345/2350 User Manual. 
На Рисунке 3 показано шасси SC-2345 с присоединенными сигнальными проводами. 
Рисунки 4 и 5 иллюстрируют два типа подключения кабеля к шасси SC-2345. 



1 Клеммы с винтовым креплением 
2 Модули SCC 
3 Винты крепления крышки 
4 Экранированный 68-контактный кабель 

5 Наклейка с краткой информацией 
6 SCC-PWRXX 
7 Разъем для модулей SCC 
8 Клеммная колодка 

9 Верхняя планка фиксации проводов 
10 Винты для прижима верхней планки 
 

 
Рисунок 3. Схема монтажа шасси SC-2345 
 

1 Экранированный 68-контактный кабель 
2 Панель фиксации проводов 
3 Модули SCC  
4 Разъем для модулей SCC 

5 Панель с BNC разъемами  
6 Индикаторы питания  
7 SCC-PWRXX 
8 Клеммы с винтовым креплением 

9 Клеммная колодка 
10 Верхняя крышка 
11 Винты крепления крышки 

 
Рисунок 4. Схема подключения шасси SC-2345 (Подключение кабеля на задней панели) 
 



1 Винты крепления крышки  
2 Верхняя крышка  
3 Клеммы с винтовым креплением  
4 Модули SCC  

5 Панель фиксации проводов  
6 Клеммная колодка  
7 Экранированный 68-контактный кабель  
8 Индикаторы питания 

9 SCC-PWRXX 
10 Панель с BNC разъемами 
11 Разъем для модулей SCC 

 
Рисунок 5. Схема подключения шасси SC-2345 (Подключение кабеля сбоку) 

Шаг 4. Подготовка шасси SC-2345/SC-2350 к работе 
Следующий раздел относится к обоим шасси – SC-2345 и SC-2350. 
Этап 1: Установка разъемов и панелей 
После выбора шасси SC необходимо установить панели с определенными типами 
разъемов. Некоторые панели могут занять более одного слота. В Таблице 1 приведены 
спецификации каждой из панелей. 
Панель Описание Кол-во разъемов Кол-во занимаемых 

слотов 
Для подключения 
термопар (мини) 

J- или K-типа 2 1 
Нескомпенсированные 2 1 

Для подключения 
термопар 

J- или K-типа 1 1 
Нескомпенсированные 1 1 

BNC Разъемы BNC 2 1 
SMB Разъемы SMB 4 1 
Banana jack Штекерные гнезда 2 1 

LEMO (B-Series) 2- контактное гнездо 2 1 
4-,6- контактное гнездо 1 1 

MIL-Spec 2-,4-,6- контактное гнездо 1 1 

9-контактный D-sub 

Одиночный (вилка) 1 2 
Одиночный (гнездо) 1 2 
Сдвоенный (вилка) 2 3 
Сдвоенный (гнездо) 2 3 

Переключатель без 
фиксации положения Вкл-выкл 2 1 

Тумблер Вкл-выкл-вкл 2 1 
Кулисный переключатель Вкл-выкл-вкл 1 1 

Светодиодная Красный, зеленый, желтый 
и оранжевый светодиоды 4 1 



Потенциометр Диапазон от 1 до 10 1 1 

Фиксация проводов Небольшая панель для 
фиксации проводов 1 2 

Без разъемов Заглушка — — 
 
Таблица 1. Возможные варианты панелей 
Выполните следующие действия для установки панелей ввода/вывода сигналов: 
1. Перед установкой панелей ввода/вывода удалите пустую панель с задней части шасси 
SC-2345/2350. 
2. Поместите нижний край панели в углубление внизу открывшегося отверстия. 
3. Прижмите верхнюю часть панели к шасси. 
4. Закрепите панель одним, двумя или тремя (в зависимости от типа панели) винтами 
M2.5×6, которые поставляются вместе с панелью. 
Освободившуюся пустую панель можно использовать в качестве заглушки 
неиспользуемого открытого слота. 
Соедините проводами установленную панель и клеммы модулей SCC или 42-контактную 
клеммную колодку, расположенную внутри шасси SC-2345/2350. 
Этап 2. Прикрепление ярлыков к панелям ввода/вывода 
В комплект поставки шасси SC-2345 с реконфигуруемыми панелями и шасси SC-2350 
входят наклеивающиеся ярлыки, которые можно прикрепить к панелям ввода/вывода, как 
показано на рисунке 6. 
1 Панель ввода/вывода 2 Ярлыки 
Рисунок 6. Прикрепление ярлыков к панелям ввода/вывода 
В комплект входят как подписанные, так и чистые ярлыки, которые можно надписать в 
соответствии с конкретными задачами. На панелях, занимающих один слот, можно 
разместить два ярлыка. На больших панелях, соответственно, большее количество. 
Сведения по установке SCC модулей 
SCC модули предназначены для согласования аналоговых входов и выходов DAQ 
устройств М серии. Цифровые линии не нуждаются в использовании SCC модулей. 
Дополнительную информацию по этому вопросу можно найти в руководстве SC-2345/2350 
User Manual. 
На крышке каждого SCC модуля расположена цветная полоска со схематическим 
изображением функции, которую выполняет модуль. Цвет полоски характеризует тип 
измерения. 
1 Клеммы с винтовым креплением 
2 Цветная полоска 
3 Модель SCC модуля 
Рисунок 7. Модуль SCC 
В таблице 2 перечислены модели SCC модулей и соответствующие им иконки, цвета 
ярлыков и типы измерений.  
Таблица 2. SCC модули: иконка, цвет ярлыка и тип измерения 
 
SCC Модуль Иконка Цвет ярлыка Тип измерения 

SCC-ACC01 Голубой Аналоговый 
ввод 

SCC_AIXX Голубой Аналоговый 
ввод 



SCC-A10 Голубой Аналоговый 
ввод 

SCC-CI20 Голубой Аналоговый 
ввод 

SCC-FV01 Голубой Аналоговый 
ввод 

SCC-LPXX Голубой Аналоговый 
ввод 

SCC-RTD01 Голубой Аналоговый 
ввод 

SCC-SG См. документ SCC-SG Series Strain Gage 
Modules User Guide 

Голубой Аналоговый 
ввод 

SCC-TC0X Голубой Аналоговый 
ввод 

SCC-FT01 

 

нет Аналоговый 
ввод/вывод, 
цифровой 
ввод/вывод, 
счетчики 

SCC-DI01 Зеленый Цифровой 
ввода/вывод 

SCC-DO01 Зеленый Цифровой 
ввода/вывод 

SCC-RLY01 Зеленый Цифровой 
ввода/вывод 



SCC-CO20 Красный Аналоговый 
вывод 

SCC-AO10 Красный Аналоговый 
вывод 

 
Шасси SC-2345 и SC-2350 имеют разную функциональность и конфигурацию 
устанавливаемых модулей. В следующем разделе приводится информация по установке 
модулей, относящаяся к конкретным моделям шасси. 
Шасси SC-2345 
Приведенная ниже информация касается шасси SC-2345. 
Ярлык с краткой информацией 
Прикрепите ярлык с краткой информацией к внутренней стороне крышки SC-2345. На 
ярлыке (см. рисунок 8) показаны возможные конфигурации SCC модулей и расположение 
контактов для подключения сигналов к модулям. Числа на ярлыке соответствуют номерам 
контактов 68-контактного разъема для устройств М-серии. 
Рисунок 8. Различные конфигурации SCC модулей в соответствии с их разъемами, выполняемыми функциями 
и цветовой кодировкой 

Схемы шасси SC-2345 
На рисунках 9, 10 и 11 показаны схемы трех типов шасси SC-2345. 
1 Разъем для установки SCC модуля  
2 Обозначение разъема для SCC модуля 
3 Ключ разъема SCC 
4 Серийный номер 
5 J24 
6 J25 
7 J21 
8 Индикаторы питания 
9 Колодка контактов с винтовым креплением 
10 Контакт заземления 
11 Номер комплекта 
Рисунок 9. Схема шасси SC-2345 
1 Индикаторы питания 
2 J21 
3 Серийный номер 
4 Номер комплекта 
5 Колодка контактов с винтовым креплением 
6 J25 
7 J24 
8 Ключ разъема SCC 
9 Обозначение разъема для SCC модуля 
10 Разъем для SCC модуля 
Рисунок 10. Схема шасси SC-2345 с конфигурируемыми разъемами (подключение на задней панели) 
1 Обозначение разъема для SCC модуля 
2 Разъем для SCC модуля  
3 Ключ разъема SCC 
4 Колодка контактов с винтовым креплением 
5 Номер комплекта 
6 Серийный номер 
7 J24 
8 Индикаторы питания 
9 J25 
10 J21 
Рисунок 11. Схема шасси SC-2345 с конфигурируемыми разъемами (подключение сбоку) 



SCC модули для согласования входных аналоговых сигналов 
Разъемы для модулей согласования входных аналоговых сигналов расположены попарно – 
J(X+1) и J(X+9) (при этом X меняется от 0 до 7). После преобразования аналоговые сигналы 
поступают в каналы AI (X) и AI (X+8) многофункционального устройства М серии. 
Например, если вы планируете установить аттенюатор SCC-A10 в разъем J4, то сигнал в 
одном канале подается на контакт AI 3, а в другом – на AI 11. Для расшифровки имен 
каналов вы можете посетить страницу ni.com/info и ввести текст rdtntg в поле 
информационного кода. 
Однокаскадное согласование входного аналогового сигнала 
В случае однокаскадного согласования входной сигнал поступает на SCC модуль и после 
преобразования подается на DAQ устройство. Поэтому, для однокаскадного согласования 
аналоговых сигналов достаточно установить один SCC модуль в любой из слотов J1 – J8 и 
подключить к нему входной сигнал. 
Двухкаскадное согласование входного аналогового сигнала 
В случае двухкаскадного согласования входной сигнал поступает на первый SCC модуль, 
выход которого последовательно соединен с входом второго SCC модуля. После второго 
согласования преобразованный сигнал подается на DAQ устройство М серии в каналы AI 
(X) и AI (X+8). Поэтому для двухкаскадного согласования аналоговых сигналов 
необходимо установить SCC модуль первого каскада в любой из слотов J(X+9), а модуль 
второго каскада – в соответствующий парный слот J(X+1). В качестве примера можно 
привести использование аттенюатора после фильтра низких частот. На рисунке 12 показана 
установка модулей согласования аналогового ввода в шасси SC-2345. 
A Однокаскадное согласование 
B Двухкаскадное согласование 
1 Разъем J9 (Модуль SCC не установлен) 
2 Модуль SCC, установленный в J1 
3 Шасси SC-2345 
4 Модуль SCC, установленный в J9 
5 Первый каскад 
6 Второй каскад 
7 Не подключайте никакого сигнала к модулю второго каскада 
Рисунок 12. Однокаскадная и двухкаскадная конфигурация модулей согласования входных аналоговых 
сигналов  
В таблице 3 перечислены модули для согласования входных аналоговых сигналов, которые 
могут быть использованы в шасси SC-2345, а также указана поддержка однокаскадной и 
двухкаскадной конфигураций. 
Таблица 3. SCC модули и совместимость с двухкаскадной конфигурацией 

Модуль SCC Однокаскадная 
конфигурация (J1–J8) 

Первый каскад 
двухкаскадной 

конфигурации (J9–J16) 

Второй каскад 
двухкаскадной 

конфигурации (J1–J8) 
SCC-AIXX Да Да Нет 
SCC-A10 Да Да Нет 
SCC-RTD01 Да Да Нет 
SCC-CI20 Да Да Нет 
SCC-ACC01 Да Да Нет 
SCC-TC0X Да Да Нет 
SCC-FV01 Да Нет Да 
SCC-LPXX Да Да Да 
SCC-FT01 Да Да Да 
SCC-SGXX Да Да Нет 
 
SCC модули для согласования цифровых сигналов 



Кроме согласования аналоговых сигналов разъемы J(Х+9) (Х меняется от 0 до 7) могут 
использоваться для установки модулей согласования цифровых сигналов. После 
преобразования шасси SC-2345 подает сигнал в цифровую линию P0.(X) DAQ устройства 
М серии. На рисунке 13 демонстрируется совместная установка цифрового и аналогового 
модулей. 
1 Шасси SC-2345 
2 Входные сигналы 
3 Цифровой SCC модуль, установленный в разъем J9 
4 Аналоговый SCC модуль, установленный в J1  
Рисунок 13. Однокаскадное согласование аналогового ввода и согласование цифровой линии 

SCC модули для согласования генерируемых сигналов 
Модули для согласования генерируемых сигналов можно устанавливать в разъемы J17 и 
J18. Хотя шасси SC-2345 назначает каждому разъему определенный канал, каждый из 
разъемов подсоединен к обоим каналам аналогового вывода DAQ устройства М серии. При 
этом назначенный канал является основным: для разъема J17 – это канал 0, для J18 – 1. 
Модули согласования сигналов счетчика 
С помощью сквозного модуля SCC-FT01 вы можете создавать приложения с 
использованием счетчиков. Разъемами для установки таких модулей служат J19 и J20 
шасси SC-2345. Первый из них J19 соединен с каналом GPCTR 0 устройства М серии, 
второй – с GPCTR 1. 
Шасси SC-2350 
Шасси SC-2350 имеет интегрированную программную поддержку TEDS датчиков 
(Transducer Electronic Data Sheet). Подробнее об использовании TEDS совместно с 
модулями SCC можно прочитать в руководстве пользователя SC-2345/2350 User Manual. 
Шасси SC-2350 содержит восемь разъемов J1 – J8, поддерживающих 16 каналов 
аналогового ввода. Разъемы расположены в один ряд и могут использоваться для 
установки модулей согласования входных аналоговых сигналов в однокаскадной 
конфигурации. Кроме этого, шасси содержит два разъема – J17 и J18 – для установки 
модулей согласования генерируемых аналоговых сигналов. 
Шасси SC-2350 не поддерживает двухкаскадную конфигурацию и согласование цифровых 
сигналов. Поэтому ряд модулей не могут применяться совместно с SC-2350. В таблице 4 
приводится список SCC модулей и их совместимость с шасси SC-2350. 
Таблица 4. Совместимость шасси SC-2350 и SCC модулей 
Модуль SCC Установка в шасси SC-2350 
SCC-ACC01 Да 
SCC-AIXX Да 
SCC-A10 Да 
SCC-CI20 Да 
SCC-FV01 Да 
SCC-LPXX Да 
SCC-RTD01 Да 
SCC-SGXX Да 
SCC-TC0X Да 
SCC-FT01 Да 
SCC-DI01 Нет 
SCC-DO01 Нет 
SCC-RLY01 Нет 
SCC-CO20 Да 
SCC-AO10 Да 
Схема шасси SC-2350 
На рисунке 14 показана схема расположения разъемов для SCC модулей, колодки 
контактов с винтовым креплением и другие функциональные блоки шасси SC-2350. 



1 Обозначение разъема для SCC модуля 
2 Разъем для установки SCC модуля 
3 Ключ разъема SCC 
4 50-контактный разъем для тестирования 
5 Серийный номер 
6 Номер комплекта 
7 Колодка контактов с винтовым креплением 
8 J24 
9 Индикаторы питания 
10 J25 
11 J21 
Рисунок 14. Шасси SC-2350 

Шаг 5. Установка модулей 
При установке модулей не прилагайте чрезмерных усилий. Правильно сориентированные 
модули легко устанавливаются в разъем. 
Для установки SCC модулей в разъемы шасси SC-2345/2350 выполните следующие 
действия: 
1. С помощью крестообразной отвертки снимите винты крепления с каждой стороны 
крышки. Откройте крышку шасси. 
2. Если шасси содержит блок фиксации проводов, ослабьте винты прижима верхней планки 
и пропустите сквозь блок сигнальные провода. Возможно, будет удобнее полностью снять 
верхнюю планку. 
3. Установите SCC модули в соответствующие разъемы. Особенности установки и 
требования к разъемам приведены в разделе Device-Specific Information руководства 
пользователя конкретного модуля SCC-XX. 
Шаг 6. Подключение сигналов 
Внимание. Перед подключением сигналов к модулю внимательно ознакомьтесь с 
техническими требованиями, приведенными в руководстве пользователя SCC-XX. 
Превышение номинальных значений напряжений и токов может привести к поражению 
оператора электрическим током, воспламенению шасси, а также выходу из строя 
устройств, подключенных к модулю. 
Для расшифровки имен каналов вы можете воспользоваться документом NI-DAQ C to NI-
DAQmx Terminal Names Translation Guide, который доступен на странице ni.com/info, если 
ввести текст rdtntg в поле информационного кода. 
Чтобы соединить проводами панели шасси и клеммы с винтовым креплением SCC модуля 
или клеммную колодку SC-2345/2350, выполните следующие действия: 
1. Отключите питание, подаваемое на сигнальные линии. 
2. Снимите изоляцию по 7 мм с концов проводов. 
3. Вставьте провода в клеммы. 
Модуль SCC-XX имеет разъем для установки блока съемных клемм с винтовым 
креплением, как показано на рисунке 15.  
1 Разъем для установки блока клемм 2 Блок съемных клемм с винтовым креплением 
Рисунок 15. Система подключение проводов к модулю SCC-XX, состоящая из двух частей 
4. Закрутите винты с усилием 0.5 – 0.6 Н·м. 
5. Если необходимо верните на место планку крепления проводов и затяните винты. 
6. Закройте верхнюю защитную крышку шасси. 
7. Для обеспечения экранировки не забудьте закрепить крышку с помощью винтов. 
Полная информация о подключении сигналов содержится в руководстве пользователя 
SCC-XX модуля, а также в руководстве User Manual к шасси SC-2345. 
SC-2350: подключение TEDS датчиков 



При использовании датчиков стандарта IEEE P1451.4 (TEDS) необходимо подключить 
сигнальные линии TEDS DATA и RETURN. Для этого выполните следующие действия, 
руководствуясь рисунком 16. 
1. Подключите линию DATA к терминалу DATA+ клеммной колодки TEDS. 
2. Подключите линию RETURN к терминалу RETURN клеммной колодки TEDS. 
Рисунок 16. Подключение линий TEDS DATA+ и RETURN 
1 DATA+ 2 2 DATA+ 10 3 RETURN 10 4 RETURN 2 
На рисунке 17 показано шасси SC-2350 с установленными SCC модулями. 
1 Винты крепления крышки 
2 Колодка контактов с винтовым креплением 
3 Колодка подключения TEDS датчиков 
4 SCC модуль — генерация аналоговых сигналов 
5 SCC-PWRXX 
6 Панель с разъемом D-Sub 
7 SCC Modules— ввод налоговых сигналов 
8 Разъемы для модулей SCC 
9 Колодка подключения TEDS датчиков: терминал RETURN 
10 Колодка подключения TEDS датчиков: терминал DATA+ 
11 Панель фиксации проводов 
Рисунок 17. Схема подключений шасси SC-2350 

Подключение цифровых сигналов 
Шасси SC-2345/2350 содержит 42-клеммную колодку с винтовым креплением, 
расположенную в три ряда и предназначенную для подключения цифровых сигналов к 
DAQ устройству М серии. Колодка соединена с линиями P0.<0..7>, +5 V, D GND, PFI 
<0..9>, CTR <0,1> GATE, CTR <0,1> OUT, CTR <0,1> SOURCE, AI SENSE, FREQ OUT, 
EXTSTROBE и AI HOLD COMP. На ярлыке с краткой информацией для шасси SC-2345 
показано соответствие цифровых линий и терминалов колодок A, В, C. Номера 
терминалов, нанесенные на ярлыки, соответствуют номерам контактов 68-контактного 
разъема устройства М серии. Подробную информацию о цоколевке разъема можно найти в 
руководстве пользователя к DAQ устройству. 
На рисунке 18 показано расположение цифровых линий на клеммной колодке. 
Рисунок 18. Соответствие цифровых линий и терминалов 
♦ Клеммная колодка шасси SC-2345 (Следующее ниже не относится к шасси SC-2345 с 
реконфигуруемыми панелями и шасси SC-2350). 
Пластины, фиксирующие провода клеммной колодки, снабжены металлизированной 
нейлоновой прокладкой, защищающей от электромагнитных помех. Поэтому, если кабель 
для подключения сигнала экранирован, его оплетку можно заземлить. Для этого 
необходимо снять изоляцию с оплетки, что автоматически обеспечит контакт с 
фиксирующими пластинами. Во избежание внесения дополнительных помех оплетку 
кабеля следует заземлять только с одного конца. Исчерпывающие инструкции по 
подключению сигналов содержатся в руководстве пользователя к модулю SCC-XX. 
Шаг 7. Запуск Measurement & Automation Explorer 
(MAX) 
Для запуска MAX дважды щелкните кнопкой мыши по иконке Measurement & 
Automation на рабочем столе Windows. 
Шаг 8. Настройка SC-2345/2350 
При работе с шасси SC-2350 допускается использование только драйвера NI-DAQmx в 
отличие от SC-2345, с которым можно применять и устаревшую версию API – Traditional 
NI-DAQ. 
1. Откройте ветку Devices and Interfaces. Если устройство не появилось в этой ветке, 
нажмите клавишу <F5> для обновления окна просмотра. Если в результате проделанных 



действий устройство не обнаружилось, посетите страницу ni.com/support/install для 
получений инструкций по устранению неисправностей. 
2. Щелкните правой кнопкой мыши по названию Devices and Interfaces и выберите опцию 
Create New в появившемся контекстном меню. 
Рисунок 19. Идентификация нового устройства в разделе Devices and Interfaces 
3. В окне Create New выберите SC-2345 или SC-2350. 
4. Выберите шасси в разделе NI-DAQmx Device»NI-DAQmx SCC Connector Block. 
Появится окно настройки, как показано на рисунках 20 и 21. 
Рисунок 20. Окно настройки клеммной колодки шасси SC-2345 
Рисунок 21. Окно настройки клеммной колодки шасси SC-2350 
Примечание. При настройке SCC системы с помощью MAX входные аналоговые каналы 
DAQ устройства М серии будут автоматически установлены в режим работы с общим 
незаземленным проводом (NRSE). 
Шаг 9. Настройка SCC модулей 
Для настройки SCC модулей в NI-DAQmx выполните следующие действия: 
1. Задайте тип шасси SCC Carrier Type. В зависимости от выбранного типа изменится 
расположение разъемов для SCC модулей. 
2. Выберите DAQ устройство DAQ Device, подключенное к шасси SC-2345/2350. 
3. Введите идентификатор клеммной колодки SCC Connector Block ID. По умолчанию 
введено SCC1. 
4. Из выпадающего меню J21 в разделе Power выберите конфигурацию источника питания 
шасси SC-2345/2350. В разъем J21 предустанавливается один из следующих модулей 
питания: 
• SCC-PWR01 — для линии постоянного напряжения 5 В DAQ устройства или внешнего 
блока питания 
• SCC-PWR02 — для универсального источника питания переменного тока 
• SCC-PWR03 — для внешнего блока питания с постоянным напряжением от 7 до 42 В 
(источник питания не входит в комплект поставки). 
Дополнительная информация о выборе модуля, подключаемого к источнику питания шасси 
SCC 2345/2350, содержится в руководстве пользователя SC-2345/2350 User Manual. 
5. В окне настройки задайте соответствие каждого из SCC модулей, установленных в 
шасси SC-2345/2350, и разъемов. Для этого щелкните левой кнопкой мыши по 
выпадающему меню разъема и выберите соответствующий модуль. 
6. Если имя модуля не приводится в списке, то, либо в данный разъем этот модуль 
устанавливать запрещено, либо текущая версия драйвера NI-DAQ устарела. Для 
обновления NI-DAQ посетите страницу ni.com/downloads. 
7. После настройки всех модулей нажмите OK. 
SC-2350: Настройка TEDS датчиков 
Чтобы настроить TEDS датчик с помощью MAX, выполните следующие действия: 
1. Если приложение не открыто, запустите MAX, дважды щелкнув левой кнопкой мыши по 
его иконке на рабочем столе. 
2. В разделе NI-DAQmx Devices, вызовите контекстное меню шасси SC-2350 и выберите 
опцию Properties. Откроется окно настройки SC-2350 Configuration. Оставьте значения 
полей DAQ Device и SCC Connector Block ID по умолчанию. 
3. Выберите SCC модуль из выпадающего списка соответствующего разъема (Jx). 
4. Если датчик подсоединен к модулю, то светодиодный индикатор справа от модуля 
загорится зеленым светом. Если светодиодный индикатор не горит, присоедините датчик и 
нажмите кнопку Scan for TEDS, затем OK. 



5. Откройте ветку SC-2350 и далее ветку с наименованием модуля, к которому 
присоединен TEDS датчик. 
6. Щелкните левой кнопкой мыши по названию TEDS датчика. В правой части окна 
появится описание его характеристик. 
7. Проверьте, что все параметры TEDS датчика были правильно импортированы, в 
противном случае повторите шаги со второго по седьмой. 
Шаг 10. Настройка каналов и задач 
В данном разделе описываются концепции программирования устройств с помощью NI-
DAQ в любой из сред NI разработки приложений. 
Физическим каналом называется терминал или контакт, на котором происходит измерение 
либо генерация аналогового или цифрового сигнала. В отличие от него, виртуальный канал 
представляет собой набор характеристик, таких как имя, физический канал, схема 
подключения сигнала, тип измерения или генерации, а также информация о 
масштабировании данных. При программировании в NI-DAQmx виртуальный канал 
является неотъемлемой частью любого измерения. В Traditional NI-DAQ 
конфигурирование виртуальных каналов необязательно и служит для их идентификации в 
различных измерительных задачах. На рисунке 22 объясняется настройка каналов в NI-
DAQmx и Traditional NI-DAQ. В случае использования TEDS датчиков программирование 
возможно только с помощью NI-DAQmx. 

Настройка каналов и задач 
Используйте MAX 
для настройки 
каналов. В случае 
затруднений 
обратитесь к 
справочной 
системе 
Measurement & 
Automation 
Explorer Help for 
Traditional NI-
DAQ. 

Traditional NI-DAQ Какой интерфейс 
используется для 
программирования 
устройства? 

NI-DAQmx Используйте помощника 
по сбору данных DAQ 
Assistant, вызываемого 
из MAX или среды 
разработки приложений 
NI, для конфигурации 
каналов и 
измерительных задач. 
Дополнительную 
информацию можно 
найти в справочной 
системе DAQ Assistant 
Help или Measurement & 
Automation Explorer Help 
for NI-DAQmx. 

Установленные и сконфигурированные устройства 
Рисунок 22. Настройка каналов и задач в NI-DAQmx и Traditional NI-DAQ 
Задачей (task) называется совокупность одного или нескольких виртуальных каналов с 
настроенными временными параметрами, синхронизацией и другими свойствами. 
Поэтому, по своему смыслу, задача представляет собой выполняемое измерение или 
генерацию сигнала. Вы можете настроить и сохранить всю информацию о конфигурации в 
задаче и затем использовать её в приложении.  
В NI-DAQmx виртуальные каналы можно настроить либо в рамках задачи, либо отдельно. 
Виртуальные каналы, созданные в рамках задачи, называются локальными каналами (local 
channels) в отличие от глобальных каналов (global channels), которые могут быть созданы 
безотносительно задачи. 
Глобальные каналы можно создать двумя способами: в MAX или же в среде разработки 
приложений с последующим сохранением в MAX. Их можно использовать в любом 
измерительном приложении и добавлять в различные задачи. Однако не забывайте, что 
изменение, произведенное в глобальном канале, повлияет на все задачи, в которых он 



применяется. Поэтому в большинстве случаев бывает проще использовать локальные 
каналы. 
Настройка задачи в NI-DAQmx 
Для настройки задачи в NI-DAQmx можно использовать помощника по сбору данных DAQ 
Assistant. Однако при этом среда разработки приложений должна быть версии не ниже 7.0 
(7.2 для SC-2350). 
• В MAX щелкните правой кнопкой мыши по разделу Data Neighborhood и выберите 
опцию Create New. В появившемся окне Create New выберите NI-DAQmx Task и нажмите 
Next. В случае использования удаленного целевого контроллера в среде LabVIEW Real-
Time откройте раздел Remote Systems, затем найдите и откройте раздел, соответствующий 
вашему контроллеру, щелкните правой кнопкой мыши по ветке Data Neighborhood и 
выберите Create New. 
• DAQ Assistant можно вызвать непосредственно из среды разработки приложений NI: 
– В LabVIEW и LabVIEW Real-Time: 
• Поместите на блок-диаграмму экспресс ВП DAQ Assistant из палитры Express Input, как 
описано в курсе Начало работы с LabVIEW. 
• Кроме этого, DAQ Assistant можно вызвать, если поместить на лицевую панель элемент 
управления DAQmx Task Name. Щелкните правой кнопкой мыши по элементу управления 
и выберите New Task (DAQ Assistant). В документе Taking an NI-DAQmx Measurement in 
LabVIEW содержатся пошаговое описание создания задачи из элемента управления 
DAQmx Task Name и генерация соответствующего кода. Для вызова документа в LabVIEW 
выберите меню Help»Taking an NI-DAQmx Measurement. 
– В LabWindows/CVI выберите меню Tools»Create/Edit DAQmx Tasks. 
– В Measurement Studio откройте Visual Studio .NET и проект, в рамках которого вы хотите 
создать класс DAQmx task. 
1. Выберите меню Project»Add New Item. Появится диалоговое окно Add New Item. 
2. В окне Categories выберите Measurement Studio»Assistants. 
3. В окне Templates, выберите DAQmx Task Class. 
4. Введите имя файла задачи DAQmx и нажмите Open. 
5. Определите, будет ли создаваться новая задача или же проект скопирует глобальную 
задачу из MAX. 
6. Нажмите Finish. 
После этого помощник DAQ Assistant откроет интерактивное окно, в котором нужно 
выполнить следующие действия для создания задачи: 
1. Выберите тип задачи, например, аналоговый ввод (analog input). 
2. Выберите тип измерения, основываясь на функциональных возможностях 
подключенного модуля. В таблице 5 перечислены типы измерительных задач NI-DAQmx и 
соответствующие им SCC модули. Дополнительную информацию о настройках 
каналов/задач, относящихся к конкретному SCC-XX модулю, можно найти в его 
руководстве пользователя. 
Таблица 5. SCC модуль и соответствующий тип измерения в NI-DAQmx 
SCC модуль Рекомендуемый тип измерения 

NI-DAQmx 
Рекомендуемые настройки 
параметров1 

SCC-ACC01 Analog Input»Accelerometer Current Excitation Value = 4 mA, 
Excitation Source = Internal 
Sensitivity = # 

SCC-AI01 Analog Input»Voltage Max/Min = ±42 V 
SCC-AI02 Analog Input»Voltage Max/Min = ±20 V 
SCC-AI03 Analog Input»Voltage Max/Min = ±10 V 
SCC-AI04 Analog Input»Voltage Max/Min = ±5 V 



SCC-AI05 Analog Input»Voltage Max/Min = ±1 V 
SCC-AI06 Analog Input»Voltage Max/Min = ±100 mV 
SCC-AI07 Analog Input»Voltage Max/Min = ±50 mV 
SCC-AI13 Analog Input»Voltage Max/Min = ±10 V 
SCC-AI14 Analog Input»Voltage Max/Min = ±5 V 
SCC-A10 Analog Input»Voltage Max/Min = ±100 V 
SCC-AO10 Analog Output»Voltage Max/Min = ±10 V 
SCC-CI20 Analog Input»Current Max = 20 mA, Min = 0 mA 
SCC-CO20 Analog Output»Current Max = 20 mA, Min = 0 mA 
SCC-DI01 Digital Input Значения по умолчанию 
SCC-DO01 Digital Output Значения по умолчанию 
SCC-FT01 Любой тип измерения В зависимости от приложения 
SCC-FV01 Analog Input»Frequency Значения по умолчанию 
SCC-LP01 Analog Input»Voltage Max/Min = ±10 V 
SCC-LP02 Analog Input»Voltage Max/Min = ±10 V 
SCC-LP03 Analog Input»Voltage Max/Min = ±10 V 
SCC-LP04 Analog Input»Voltage Max/Min = ±10 V 
SCC-RLY01 Digital Output Значения по умолчанию 
SCC-RTD01 Analog Input»Temperature»RTD Current Excitation Value = 1 mA 

Excitation Source = Internal 
RTD Type = # 
R0 = # 
Resistance Configuration = #

SCC-SG01 Analog Input»Strain Gage Strain Configuration = Quarter 
Bridge I 
Gage Resistance = 120 Ω 
Gage Factor = # 

SCC-SG02 Analog Input»Strain Gage Strain Configuration = Quarter 
Bridge I 
Gage Resistance = 350 Ω 
Gage Factor = # 

SCC-SG03 Analog Input»Strain Gage Strain Configuration = Half Bridge I 
Gage Resistance = # 
Gage Factor = # 
Poisson Ratio = # 

SCC-SG04 Analog Input»Strain Gage Strain Configuration = Full Bridge I 
Gage Resistance = # 
Gage Factor = # 

Analog Input»Custom Voltage 
with Excitation 

Max/Min = ±100 mV 
Bridge Type = Full Bridge 
Excitation Source = Internal 
Excitation Value = 2.5 V

SCC-SG24 Analog Input»Strain Gage Strain Configuration = Full Bridge I 
Excitation Value = 10 V 
Gage Resistance = # 
Gage Factor = # 

Analog Input»Custom Voltage 
with Excitation 

Max/Min = ±100 mV 
Bridge Type = Full Bridge 
Excitation Source = Internal 
Excitation Value = 10 V 

SCC-SG11 Digital Output Значения по умолчанию 
SCC-TC01 Analog Input»Temperature» 

Thermocouple
CJC Source = Built In 
Thermocouple Type = # 

SCC-TC02 Analog Input»Temperature» 
Thermocouple

CJC Source = Built In 
Thermocouple Type = # 

1Для параметров, не указанных в таблице, использовать значения по умолчанию. 
# Выбирать в соответствии с характеристиками датчика. 



3. Если в измерении используется датчик, выберите его тип. Нажмите Next. Появится 
диалоговое окно дальнейшей настройки задачи. 
4. Выберите каналы, которые должны входить в задачу. Если система настроена на 
использование TEDS датчиков, переключитесь на вкладку TEDS Channels. Выберите 
физический канал(ы). После этого DAQ Assistant считает настройки из датчика и создаст 
задачу. Нажмите Next. 
5. Введите имя созданной задачи. Нажмите Finish. 
Рисунок 23. DAQ Assistant 
6. Если необходимо, выполните настройки параметров вашей измерительной задачи, а 
именно, временных характеристик, синхронизации и масштабных факторов. 
7. Сохраните задачу. 
• Если DAQ Assistant был открыт из LabVIEW либо LabWindows/CVI, нажмите OK. 
• Если DAQ Assistant был открыт из Measurement Studio, выберите меню File»Save. 
• Если настройка осуществлялась в MAX, нажмите Save Task. 
8. Нажмите Test. Проверьте данные в открывшемся окне. Если они неправильны, 
проверьте информацию, считываемую из TEDS датчика, и соответствующие настройки в 
окне DAQ Assistant. 
Примечание. С помощью DAQ Assistant невозможно создание задачи, содержащей каналы с 
разными типами измерений, например, напряжения и температуры. Это необходимо 
сделать программно. Описание этого приводится в разделе More Than One Measurement 
Type in a Task на странице ni.com/support. 
Теперь задача готова для использования в приложении. Подробная информация об этом, а 
также о генерации кода в вашей среде программирования, содержится в справке DAQ 
Assistant Help. 
Настройка глобальных каналов в NI-DAQmx 
При использовании NI-DAQmx глобальные каналы можно настраивать с помощью DAQ 
Assistant. 
• Для запуска DAQ Assistant в MAX щелкните правой кнопкой мыши по разделу Data 
Neighborhood и выберите в контекстном меню опцию Create New. 
В случае использования удаленного целевого контроллера откройте раздел Remote 
Systems, затем найдите и откройте раздел, соответствующий вашему контроллеру, 
щелкните правой кнопкой мыши по ветке Data Neighborhood и выберите Create New. 
В окне Create New выберите NI-DAQmx Global Channel и нажмите Next. 
• DAQ Assistant можно вызвать непосредственно из среды разработки приложений NI: 
– В LabVIEW и LabVIEW Real-Time используйте элемент управления DAQmx Global 
Channel. Вызовите контекстное меню этого элемента и выберите опцию New Channel 
(DAQ Assistant). 
– В LabWindows/CVI или Measurement Studio сначала необходимо создать задачу, как 
описывалось ранее. Затем в DAQ Assistant выбрать опцию Add Existing DAQmx Global 
Channels для добавления глобальных каналов к вашей задаче. Поэтому для создания 
глобальных каналов необходимо использовать MAX. 
Откроется DAQ Assistant и предложит вам создать новый глобальный канал. После этого: 
1. Выберите тип канала, например, аналоговый ввод. 
2. Определитесь, хотите ли вы выполнять измерение или генерацию сигнала. 
3. Если в измерении используется датчик, выберите его тип. 
4. Диалоговое окно попросит вас выбрать каналы, которые должны входить в задачу. Вы 
можете выбрать как физические каналы, из которых будут созданы локальные каналы в 
задаче, так и глобальные каналы. 



Если ваша система настроена на использование TEDS датчиков, переключитесь на вкладку 
TEDS Channels. Выберите физический канал(ы). После этого DAQ Assistant считает 
настройки из датчика и воспользуется этой информацией для создания задачи. Нажмите 
Next. 
5. Введите имя нового глобального канала. Нажмите Finish. 
6. Выполните настройки параметров вашей измерительной задачи. Если один или 
несколько каналов используют TEDS датчики, то ряд настроек, загруженных из таблиц 
датчика, нельзя будет редактировать. 
7. Сохраните канал. 
• Если DAQ Assistant был открыт из LabVIEW либо LabWindows/CVI, нажмите OK. 
• Если DAQ Assistant был открыт из Measurement Studio, выберите меню File»Save. 
• Если настройка осуществлялась в MAX, нажмите Save Channel. 
8. Нажмите Test. Проверьте данные в открывшемся окне. Если они неправильны, 
проверьте информацию, считываемую из TEDS датчика, и соответствующие настройки в 
окне DAQ Assistant. 
Теперь глобальный канал готов для использования в приложении либо для добавления в 
задачу. Подробная информация об этом, а также о генерации кода, содержится в справке 
DAQ Assistant Help либо в документации к вашей среде программирования. 
Шаг 11. Использование задачи в приложении 
Выполните следующие действия, чтобы использовать измерительную задачу в LabVIEW: 
1. Откройте LabVIEW и выберите создание нового ВП. 
2. Поместите константу NI Measurement»DAQmx-Data Acquisition»DAQmx Task Name 
Constant на блок диаграмму. 
3. Выберите задачу из выпадающего меню константы. 
4. Вызовите контекстное меню константы и выберите опцию Generate Code»Example 
(Генерация кода»Пример). 
5. Запустите программу с лицевой панели. 
Подробная информация об использовании канала и генерации кода в средах 
LabWindows/CVI или Measurement Studio содержится в их документации и справке DAQ 
Assistant Help. 
Разработка приложений 
Использование примеров 
В любой среде программирования содержится набор примеров, помогающих в разработке 
специализированного приложения. Вы можете использовать примеры, например, 
модифицируя их код и сохраняя его в своем приложении.  
Для просмотра примеров программ в LabVIEW и LabWindows/CVI откройте 
специализированное приложение – National Instruments Example Finder. Для этого: 
• В LabVIEW выберите меню Help»Find Examples. 
• В LabWindows/CVI выберите меню Help»NI Example Finder. 
• Примеры программ на базе API NI-DAQmx для сред, поддерживающих Measurement 
Studio, находятся в следующих папках 
– MeasurementStudioVS2003\VCNET\Examples\DAQmx 
– MeasurementStudioVS2003\DotNET\Examples\DAQmx 
• Следующие ресурсы иллюстрируют использование интерфейса Traditional NI-DAQ в 
среде Visual Basic: 
– Директория NI-DAQ\Examples\Visual Basic with Measurement Studio содержит 
примеры совместного использования технологии ActiveX control и Measurement Studio. 



– Директория NI-DAQ\Examples\VBasic содержит примеры программ, не использующих 
Measurement Studio. 
• Примеры кодов NI-DAQmx для ANSI C расположены в папке NI-DAQ\Examples\DAQmx 
ANSI C. 
• Примеры применения Traditional NI-DAQ в среде ANSI C находятся в папке NI-
DAQ\Examples\VisualC. 
Сотни других примеров можно найти на странице ni.com/zone. 
Информация об измерительных приложениях и устройствах 
Ниже приведены источники дополнительной справочной информации о средах разработки 
приложений и устройствах, применяемых для автоматизации измерительных задач. 
• LabVIEW 
– Для первого знакомства с LabVIEW вы можете использовать краткий курс Getting Started 
with LabVIEW (существует версия на русском языке – Начало работы с LabVIEW). 
Выберите меню Пуск»Все программы»National Instruments»LabVIEW 7.x»Search the 
LabVIEW Bookshelf. 
– Руководство LabVIEW Measurements Manual содержит описания программных 
интерфейсов Traditional NI-DAQ и NI-DAQmx, а также базовых концепций проведения 
измерений. Выберите меню Пуск»Все программы» National Instruments»LabVIEW 
7.x»Search the LabVIEW Bookshelf. 
– Документ Taking an NI-DAQmx Measurement in LabVIEW содержит пошаговые 
инструкции по выполнению измерений с помощью LabVIEW, а также описания ключевых 
понятий, таких как задачи (task), и утилит NI-DAQmx, таких как помощник по сбору 
данных DAQ Assistant. В среде LabVIEW выберите меню Help»Taking an NI-DAQmx 
Measurement. 
– В документах LabVIEW Traditional NI-DAQ VI Reference Help и LabVIEW NI-DAQmx VI 
Reference Help содержатся описания ВП и их свойств в случае использования интерфейсов 
NI-DAQmx и Traditional NI-DAQ. Для вызова этих документов в LabVIEW выберите 
Help»LabVIEW Help, затем найдите раздел, относящийся к выбранному интерфейсу. 
• LabVIEW Real-Time – набор документов, касающихся модуля LabVIEW Real-Time, 
можно найти в меню Пуск»Все программы»National Instruments»LabVIEW 7.x»Module 
Documents»Search the LabVIEW Real-Time Module Bookshelf. 
• LabWindows/CVI – для первого знакомства с LabWindows/CVI вы можете использовать 
краткий курс Getting Started with LabWindows/CVI (существует версия на русском языке – 
Введение в LabWindows/CVI). В LabWindows/CVI выберите меню Help»LabWindows/CVI 
Bookshelf. Справочная система LabWindows/CVI Help содержит описание функций и 
принципов проведения измерений с помощью NI-DAQmx. Для вызова справки выберите в 
LabWindows/CVI меню Help»Contents. 
• Measurement Studio – справка NI Measurement Studio Help содержит описания NI-DAQmx 
API, измерительных задач, принципов, функций. Справочный файл интегрирован в 
документацию среды программирования Visual Studio .NET, поэтому для его вызова 
выберите меню Help»Contents. 
Документ Measurement Studio Reference содержит описания Traditional NI-DAQ API, 
измерительных задач, принципов, функций. В среде Visual Studio .NET выберите меню 
Measurement Studio»Measurement Studio Reference. 
• Программирование в ANSI C – описания API содержатся в руководстве пользователя 
Traditional NI-DAQ User Manual и справке NI-DAQmx Help. Кроме этого, в NI-DAQmx Help 
приводится базовая информация о принципах проведения измерений. Справочные файлы 
Traditional NI-DAQ C Reference Help и NI-DAQmx C Reference Help описывают C функции и 



атрибуты. Для вызова документов выберите меню Пуск»Все программы»National 
Instruments»NI-DAQ»заголовок, соответствующий выбранному NI-DAQ API. 
• Программирование в .NET – справка NI Measurement Studio Help содержит описания NI-
DAQmx API, измерительных задач, принципов и функций. Справочный файл интегрирован 
в документацию среды программирования Visual Studio .NET, поэтому для его вызова 
выберите меню Help»Contents. 
Примечание. При использовании языка программирования .NET без оболочки Visual 
Studio .NET вы, возможно, не сможете вызвать справочный файл NI Measurement Studio 
Help. 
• Документация к устройству – программный пакет NI-DAQ 7.x содержит обширный набор 
справочной информации для поддерживаемых устройств и принадлежностей, включая PDF 
и гипертекстовые файлы, в которых приводится описание терминалов устройств, их 
спецификации, особенности, режимы работы и т.д. Для нахождения, просмотра и 
распечатки определенных документов поместите в дисковод CD диск Device 
Documentation. После установки справочной системы её можно вызвать из меню Пуск»Все 
программы»National Instruments»NI-DAQ»Browse Device Documentation. 
Техническая поддержка 
Посетите сайт ni.com компании National Instruments: 
• Поддержка – всесторонняя оперативная техническая поддержка на ni.com/support 
охватывает: 
– Самостоятельный поиск – Для получения ответов и решений посетите веб-сайт 
компании National Instruments, на котором вы найдете драйверы и последние обновления, 
Базу знаний с системой поиска, руководства ко всем продуктам, пошаговых мастеров 
устранения неполадок, тысячи примеров программ, полезных советов и многое другое. 
– Бесплатная техническая поддержка – Все зарегистрированные пользователи получают 
бесплатные консультации у сотен разработчиков приложений по всему миру на форуме 
«NI Discussion Forums» по адресу ni.com/forums. Разработчики компании National 
Instruments гарантируют, что вы получите ответ на каждый заданный вопрос. 
• Обучение и сертификация – National Instruments предлагает различные учебные курсы и 
сертификационные экзамены для проверки ваших знаний и квалификации специалиста. 
Программы учебных курсов разработаны на основе 15-летнего опыта обучения 
пользователей при участии инженеров-разработчиков NI и имеют практическую 
направленность. Программы всех курсов имеют модульную структуру, так что вы можете 
выбрать наиболее подходящие курсы для вашей области деятельности. Обучение 
проводится на оборудовании National Instruments в учебном классе компании или на 
территории заказчика. Курсы имеют проходят под руководством опытных преподавателей, 
всегда готовых ответить на специфические для вашего приложения вопросы. В ходе 
проведения курсов слушателям предоставляются методические пособия и учебники на 
русском языке, по окончании выдаются сертификаты международного образца. Подробнее 
о курсах на ni.com/russia, раздел Курсы 
• Заявление о соответствии (declaration of conformity) – ЗоС – это подтверждение 
соответствия с Советом европейского экономического сообщества (Council of the European 
Communities), которое использует заявление о соответствии от производителя. Эта система 
обеспечивает пользователю сертификат электромагнитной совместимости и техники 
безопасности оборудования. ЗоС для вашего оборудования можно получить в разделе 
ni.com/hardref.nsf. 



• Сертификат калибровки (Calibration Certificate) – Если ваше оборудование 
поддерживает калибровку, вы можете получить сертификат калибровки в разделе 
ni.com/calibration. 
 
Если вы искали помощь на ni.com и не нашли ответа, обратитесь за бесплатной 
технической поддержкой в офис National Instruments: 
 
National Instruments Россия, СНГ, Балтия 
119361 г. Москва, ул. Озерная, д.42 офис 1101  
Телефон в Москве: + 7(495) 783-68-51  
Телефон в Санкт-Петербурге: + 7 (812) 951-44-18 
Телефон в Киеве: + 38 (068) 394-21-22 
Электронная почта: support.russia@ni.com 


